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SYSTEM REQUIREMENTS
MINIMUM CONFIGURATION
❐ MS-DOS® 5.0 or higher (Windows 95 compatible)
❐ Pentium™ 90 MHz or faster processor
❐ Minimum 28 MB disk space free for hard drive installation
❐ 16 MB RAM
❐ 1 MB VESA compatible PCI video card
❐ 4x-speed CD-ROM
❐ Keyboard
❐ Microsoft mouse or 100% compatible

RECOMMENDED CONFIGURATION
❐ Pentium 120 MHz or faster processor
❐ Sound Blaster™ or 100% compatible sound card

SUPPORTED
❐ 2-6 player network support using IPX network protocol (high performance systems recom-

mended)
❐ 100% Hayes compatible 14.4 kbps or faster modem for 2 player modem play
❐ Sound Cards: Ensoniq SoundScape, ESS AudioDrive, Gravis Ultrasound, Gravis Ultrasound

Max, MS Windows Sound System, Pro Audio Spectrum 16, Reveal FX/32, Roland RAP-10,
Sound Blaster, Sound Blaster Pro, Sound Blaster 16, Sound Blaster AWE32, 100% Sound
Blaster compatibles, Sound Galaxy NX Pro 16, Vibra 16

INSTALLATION

DISK PREPARATION
Before you install any software, it is critical that your hard drive be in proper working order. We
recommend running SCANDISK or DEFRAG (DOS 6.2 or higher). SCANDISK searches your
hard drive for any lost allocation units as well as any cross-linked files and directories. DEFRAG
ensures that your data is sorted properly. Failure to verify this may result in corrupt data.
Steps for running these preventative applications are given on the next page for DOS and Windows®

95.
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DOS PREPARATION
1. Type VER e from the DOS C:> prompt. Your DOS version is displayed on the screen. If
it says ‘MS-DOS VERSION 6.21’ or any version later than 6.2, follow the steps below. If you are
using DOS version 5.0, you may need to use other utilities (such as Norton Utilities™ or Central
Point Tools) to check your drive’s condition.

2. Type SCANDISK C: e from the DOS prompt. This will determine if your drive is in good
repair. If any damage is found, you should repair it before continuing, following the instructions
in your DOS manual.

3. Type DEFRAG C:/F e from the DOS prompt. This runs a complete defragmentation on
your hard disk to ensure all your data is sorted properly. It also optimizes your hard disk for faster
load and access times.

WINDOWS 95 PREPARATION
The procedure for scanning and defragmenting your disk from Windows 95 is essentially the
same as from DOS—only the method for starting the programs is different.

1. First, run SCANDISK. To start SCANDISK, left-click on the ÿStart button from the
Taskbar. The Start menu opens.

• From the Start menu, highlight Programs, and then select Accessories from the menu
that appears. Yet another menu appears–from that menu, select System Tools. Finally,
highlight ScanDisk, and the program starts.

• Once activated, make sure there is a check mark in the Automatically Fix Errors box
and select the hard drive you are installing the game to (e.g., C:). Once everything is set up
correctly, click Star t to have the program scan the drive and correct any errors.

2. Next, run DEFRAG. To start DEFRAG, go to System Tools (as in the previous step) and
highlight Disk Defragmenter. As with SCANDISK, select the drive you are installing the game
to and click OK.

DOS INSTALLATION
1. Insert the Krush, Kill ‘N Destroy CD in your CD drive.

2. At the DOS prompt, type D: e to change to your CD drive (substitute the correct letter
of your CD drive if other than ‘D:’).

3. When you see the ‘D:’ prompt, type INSTALL e to start the installation program.

4. You are asked if you wish to use UniVBE™ as your Vesa driver.

• To install the driver, press Y.
✔ NOTE: This will enhance game performance. However, if you experience any difficulty please

run the install program again and press N.

3

KKND REFERENCE CARD

install3.qxd  12/22/97 1:22 PM  Page 3



5. The Installation program begins. To leave the Installation program at any time, select QUIT.
6. After a moment, the Sound Card Setup menu appears.

• To have the Install program try to detect your sound card and sound card settings automati-
cally, select AUTOMATIC. After your sound card settings are detected, select TEST to make
sure thesound card is working properly. You should hear a brief sound clip Click OK to con-
tinue.

• If you know your sound card type and settings, select MANUAL to set it up yourself.
7. After you have set up your sound card, you are asked to enter your CD-ROM drive letter
(e.g.,’D’). Click OK to continue.

8. Enter the location where you want to install KKND. By default KKND is installed to
C:\KKND. If you want to install to another drive or directory, enter the path and click OK.

9. Choose the amount of information installed to your hard drive.

• To fully install the game, choose MAXIMUM. This option takes more hard drive space, but
allows the game to load and run faster. A confirmation screen appears showing the amount of
disk space needed and available. Click YES to continue, NO to go back and make changes.

• To save space, choose MINIMUM.
10. After you have made all your selections the Installation Summary screen appears. If the infor-
mation is correct, click YES to begin copying files to your hard drive.

• To go back and make a change, click NO.
11. When installation is complete, you are given an option to view the Readme file. This file con-
tains any last minute updates and changes.

• To view the Readme file, click YES. Click NO to skip the Readme file.
12. After viewing the Readme file, click OK to leave the Installation program.

✔ NOTE: If you need to make changes to the KKND setup, run the Installation program again,
select RECONFIGURE, and follow the above instructions starting at Step 5.

WINDOWS® 95 INSTALLATION
1. Start the Windows 95 operating system.

2. Insert the KKND CD into your CD drive. The autorun Installation screen appears:

INSTALL Start installing the game REFERENCE Install/view electronic manual

PLAY Start playing after installation UNINSTALL Remove KKND from your system

HELP View the game’s Readme file QUIT Close the installation screen

✔ NOTE: If the Installation screen does not appear, click the Start button on the Taskbar, then
click Run…. The Run dialog box appears. Type type D:\INSTALL and click OK (substitute
the correct letter of your CD drive if other than ‘D:’).
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• To leave the Installation program at any time, select QUIT.
3. Left-click INSTALL to start installation.

Follow the DOS Installation instructions starting at Step 4 to complete installation.

4. To play, insert the game CD and select PLAY from the Autorun menu.

REMOVING KKND

FROM DOS
1. Go to the directory or folder where KKND is installed. By default, KKND is installed to
C:\KKND.

2. Type KILLKKND.BAT [install_path] and press e (substitute the correct location of KKND
if other than 'C:\KKND'). "[install_path]" refers to the location of KKND on your hard drive.

✔ EXAMPLE: If you installed to the default location, you would type KILLKKND.BAT C:\KKND

e.
3. Type DELTREE C:\KKND and press e. All KKND files are removed from your hard drive.

FROM WINDOWS 95
1. Click the ÿStart button on the Taskbar, then click Run…. The Run dialog box appears.
Type c:\kknd\killkknd.bat [install_path] and click OK (substitute the correct location of KKND
if other than 'C:\KKND'). "[install_path]" refers to the location of KKND on your hard drive.

✔ EXAMPLE: If you installed to the default location, you would type c:\kknd\killkknd.bat
c:\kknd e.

2. When the uninstall program has finished, close the MS-DOS Prompt window.

3. Now open the Windows Explorer and remove the 'KKND' folder from your hard drive. All
KKND files are removed from your hard drive.

STARTING THE GAME FROM DOS
1. Insert the CD in your CD drive.

2. At the DOS prompt, move to the directory where the game is installed. By default, it is
installed in C:\KKND, so you would type:

C: e
CD \KKND e

3. To start the program, type KKND.EXE e. The introduction screens appear.

• At each screen, press q to advance to the next screen. The Game Setup menu appears. For
complete gameplay instructions, please refer to the electronic KKND manual (see p. 19 for
details).
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STARTING THE GAME FROM WINDOWS 95
1. Insert the CD in your CD drive.
2. Start the Windows 95 operating system.
• On systems that have AutoPlay: KKND loads.
• On systems that don’t have AutoPlay: From the Taskbar, click the ÿStart button, then

click Run…. The Run dialog box appears. Type C:\KKND\KKND.EXE. (If KKND is installed
in a different location, substitute the correct path.)

3 The introduction screens appear.
• At each screen, press q to advance to the next screen. The Game Setup menu appears. 
✔ NOTE: For complete gameplay instructions, please refer to the electronic KKND manual.

See p. 19 for details.

PROBLEMS WITH YOUR SOFTWARE?
If you are having a problem installing or using your software, we want to help.
❐ First, please read thoroughly the Installation and System Requirements sections above.
If you have followed the directions and are still having trouble installing or operating the soft-
ware, below are some hints that might help solve the problem.

✔ NOTE: Before trying the following suggestions, please make sure you’re familiar with
the DOS commands being used. Consult your MS-DOS manual for more information.

CD PROBLEMS
A quad-speed CD-ROM drive is required to run KKND.

RECEIVE “FILE NOT FOUND” ERROR MESSAGE WHEN INSTALLING/RUNNING GAME
• Make sure the game was properly installed. See Installation on p. 2.
• Make sure the CD is in the CD drive. It must be in the drive to install or run the game.
• Make sure that the correct driver for your CD drive is loaded in your AUTOEXEC.BAT and

CONFIG.SYS files. (Example: In AUTOEXEC.BAT, your CD driver line could be: “C:\WIN-
DOWS\MSCDEX /D:MSCD001 /M:10”, and in CONFIG.SYS, the CD device driver might
appear similar to “DEVICE=C:\DEV\HIT-IDE.SYS /D:MSCD001”.)

❐ Keep in mind that your CD driver will always contain a ‘D/:xxx’ switch in both the
AUTOEXEC.BAT and CONFIG.SYS files that signifies the CD-ROM device name.

THE MOVIES ARE KIND OF JERKY
❐ Non-smooth movie playing could mean your CD ROM drive isn’t fast enough-KKND

requires at minimum a quad-speed, 600 KB per second CD-ROM drive. If the movies are
really giving you trouble, you can always skip them and just get a brief text version of each
mission by pressing q during a mission and selecting Mission Briefing.
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UNDER WINDOWS 95, THE MOVIES ARE STILL JERKY
❐ You may need to optimize your CD performance. Under Windows 95, open the Control

Panel window, and double click the System Properties icon, then click on the Performance
tab (up top). Once in the Performance Options window, click the File System button, then
click the CD-ROM tab. Using the option to optimize your performance, make sure the set-
ting reflects the actual speed of your CD-ROM drive.

VIDEO PROBLEMS
KKND requires a VESA-compatible SVGA video card capable of 640x480 with 256 colors (512K
or more video RAM).

✔ NOTE: You must have VESA support either built in to the video card or a VESA driver
installed on your system before executing this program for the game to run as intended.

If you still are experiencing difficulties with video you may want to consult your video card’s man-
ual for specific information on loading a manufacturer-specific VESA driver

GENERAL VIDEO CARD INFORMATION
❐ If your card has a built-in VESA driver, you do not have to load a VESA driver.
❐ Please contact your video card manufacturer with any VESA driver or video card issues.

I CAN’T GET KKND TO RUN ON MY LAPTOP
❐ Often laptops use non-standard video and sound hardware. You may have to experiment

with the sound settings to get KKND to function correctly. You may have to play with color
as well. Try setting it to 24-bit color mode—often, KKND won’t run correctly when the lap-
top is set to 256 color mode.

KKND RUNS SLOWLY ON MY MACHINE
❐ Try running a VESA driver, like UNIVBE. It’ll improve your video performance. Also, don’t for-

get that KKND works better if your video card supports a linear frame buffer.

MEMORY PROBLEMS
KKND requires 500K free conventional memory and 16 MB of extended memory (XMS) to run.

RECEIVE “OUT OF MEMORY” MESSAGE
Your system does not have enough free memory available.

❐ Make sure your system has at least 16 MB of RAM.
❐ Make sure you have at least 500K conventional memory and 15 MB XMS free:
• Type MEM /C e from the DOS prompt to check the amount of available memory on your

system. A memory summary statement similar to the following is displayed (exact numbers
will vary by system):
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Type of Memory Total Used Free
Conventional 651,360 63,344 592,016
Upper 158,560 156,256 2,304
Reserved 393,216 393,216 0
Extended (XMS) 15,570,080 2,385,056 13,185,024
Total memory 16,777,216 2,997,882 13,779,344

Total under 1 MB 813,920 219,600 594,320
Largest executable program size 591,872 (578K)
Largest free upper memory block 1,284 (0K)
MS-DOS is resident in the high memory area.

The important numbers are bold. The “Extended (XMS)” line must read 15,360,000 bytes or
higher in the “Free” column. The “Largest executable program size” line must read 512,000
(500K) or higher. To learn how to free up additional memory, see Creating a Boot Disk, p. 13.

KKND WON’T LOAD
❐ First, are you in the directory where KKND has been installed (usually C:\KKND)? Secondly,

have you got at least 500K of free conventional memory? Thirdly, have you got enough free
upper memory, ‘cause you’ll be needing at least 15 MB free. Fourthly, if your machine has 16
MB of RAM, are other programs residing in upper memory that you could maybe remove?

GENERAL MEMORY INFORMATION
❐ You must use an extended memory manager—we strongly recommend using HIMEM.SYS

rather than other memory managers such as QEMM.SYS.
❐ We recommend that you temporarily disable any nonessential utilities you may be running in

order to free up more memory on your system. Examples of such include:
EMM386.EXE ANSI.SYS
SMARTDRV.SYS ANYKEY.COM
POWER.EXE RESUME.SYS
IFSHLP.SYS ASP.SYS
CSP.SYS VSAFE.EXE
VSHIELD.SYS SHARE.EXE
DOSKEY.COM PS1TOOLS (any utiltity)
Any network drivers you may normally load

SOUND PROBLEMS
KKND supports AdLib Gold, Aria Chipset, Ensoniq Soundscape, ESS Audio Drive, Gravis
Ultrasound™, Gravis Ultrasound Max, I/O Magic Tempo, Microsoft Sound System, New Media
WAV Jammer, Pro Audio Spectrum 16, Reveal FX/32, Roland RAP-10, Sound Blaster™, Sound
Blaster Pro™, Sound Blaster 16™, Sound Blaster AWE32, Sound Galaxy NX Pro 16,
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Thunderboard, Toptek Golden 16, and Vibra 16.

INSTALLED SOUND CARD, BUT THERE IS NO SOUND
❐ Make sure your speakers or headphones are plugged into the appropriate jack and the volume

control is turned up.
❐ Make sure you selected the correct sound card.
❐ Check to see if the file “THEVOICE.CFG” exists in the root directory of your C drive (C:\). If

not, run ‘INSTALL.EXE’ on the CD-ROM and go through the audio configuration process.
This will copy “THEVOICE.CFG” into C:\.

❐ Refer to Sound Configuration below.

INSTALLED SOUND CARD, BUT GET STATIC FROM SPEAKERS
❐ Make sure you selected the correct sound card.

MY SOUND CARD DIDN’T MAKE IT TO THE LIST
❐ Your sound card must be 100% compatible with one of the supported sound cards.

KKND FREEZES WHEN VIDEO IS PLAYED
❐ Strangely enough, this could be an audio problem. Check that your audio configuration is prop-

erly set up from the install program.

SOUND CONFIGURATION
Make sure the appropriate statement for your sound card is included in your AUTOEXEC.BAT file:

Sound Card Statement
Sound Blaster SET BLASTER=[settings] T1
Sound Blaster Pro SET BLASTER=[settings] T4
Sound Blaster 16 SET BLASTER=[settings] T6
Gravis Ultrasound SET ULTRASOUND=220,1,1,11,15
Gravis Ultrasound Max SET ULTRASOUND=220,1,1,11,15 ULTRINIT

❐ If the appropriate statement is not included in the AUTOEXEC.BAT, consult your sound
card documentation and/or run the configuration utility for your sound card.

NETWORK PROBLEMS

CAN’T SELECT IPX FROM THE MULTIPLAYER SCREEN
❐ If you don’t have a network connection and IPX drivers loaded, your IPX button will be

dimmed out and unselectable. Check with your network person to find out if your network
supports IPX and whether your machine has the drivers configured for it.

MY NETWORK GAME DOESN’T WORK
❐ There might just be too many users on your LAN.
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❐ You and your intended war victim may be on opposite sides of a network router. This can
cause all sorts of problems, and you’d be better off using a computer on the same router.

❐ Maybe your LAN card is letting you down. Check it’s not damaged or installed incorrectly—
intense, precise games such as KKND sometimes bring out the worst in card faults.

THE NETWORK GAME IS RUNNING, BUT IT’S A BIT SLUGGISH
❐ Slow, busy or unreliable networks can cause multiplayer KKND to run correspondingly slow-

ly. Also remember that a network game will only run as fast as the slowest computer being
used in a group, so that all machines in the group remain synchronized.

MODEM PROBLEMS

MY MODEM GAME IS NOT WORKING PROPERLY
❐ After making sure that everything is switched on, check that error correction and data com-

pression are disabled. If they aren’t and you’re not sure how to activate them, consult the
modem’s manual. While you’re fiddling, make sure that your phone does not have Call Waiting
enabled. If you don’t know how to turn off Call Waiting, check with your phone company. 

❐ You’ve been sitting at the Awaiting Connection screen for a while and you’re starting to suspect
that KKND has, well, hung? You might have a noisy line, which, if it happens a lot, could be
worth a call to your phone company. Also, make sure your baud rate isn’t too high for the game.

❐ The slowest computer or modem sets the pace for all other machines and modems in the
multiplayer game. Bad telephone lines or very long serial cables may also be to blame.

MODEM PLAY IS SLOW
❐ Modem performance can often be increased by switching the music level to zero. To do this,

go to the Options menu (press O), click OPTIONS and drag the Music slider all the way to
the left.

NOT CONNECTING
❐ It is possible that your modem doesn’t support a standard initialization string. You can

change this string and other modem settings by editing the SERIAL.CFG file in the directory
where you installed KKND.

SERIAL PROBLEMS

SERIAL CONNECTIONS UNDER WINDOWS 95
❐ Make sure that the serial ports on both machines are set to the same baud rate. To check the

baud rate for you serial port, select the System icon from the Control Panel. Click the
Device Manager tab and double-click the Ports (COM & LPT). Highlight the port you are
using to make a connection, then click the Properties button. Click the Port Settings tab.
The Bits per second: number is displayed. We suggest using a setting of 9600, but you
should try other settings to find the best rate for your system.
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GENERAL TROUBLESHOOTING

I CAN’T GET KKND TO INSTALL ONTO MY HARD DRIVE
❐ Do you have enough free hard drive space? You need 20 MB for a minimum install, and 60

MB for a full one, assuming you don’t have any disk compression systems running. If you do,
well you can just about double the amount of space you need (to 60 MB for minimum install
and 110 MB for the full). And maybe you could think about not using a disk compression
system with KKND-it’s under enough pressure as it is.

KKND STILL DOESN’T RUN
❐ View the README.TXT file in the root directory of the CD-ROM. You can do this by typ-

ing type readme.txt |more e. Check the Last-Minute-Things-To-Go-Wrong section for
any additional information.

SYSTEM-SPECIFIC ISSUES

COMPAQ SYSTEMS
Users who have a standard Compaq PC with a manufacturer-installed sound card may need to add
some important parameters to one of the startup files in order to get sound with this program.

Sound Blaster-compatible cards need the proper environment settings in your AUTOEXEC.BAT
startup file. To determine if your system has these settings follow the steps below.

• From the DOS “C:\>” prompt, type SET e.
• The list displayed is the environment currently running on your system. If this list doesn’t

contain any line that reads “BLASTER=<settings>” your system is not properly equipped.
You will need to either create a boot disk in order to add this line or add it to your C:\AUTOEX-
EC.BAT file. (WARNING: We strongly recommend using a boot disk, as this will not make any
permanent changes to your system’s configuration.) The correct syntax and proper settings of this
line must be typed exactly as follows:

SET BLASTER=A220 I5 D1
REMEMBER: Always reboot after making any changes to your system, and re-run the setup utili-
ty in the game’s directory. Choose Sound Blaster only. Test, if this is still a problem consult the
reference material for other noted suggestions.

GATEWAY SYSTEMS
Included with your Gateway packaging is an orange envelope labeled ‘DO NOT THROW
AWAY! This envelope contains your SYSTEM DISK’. This system disk must be installed to access
your CD-ROM drive in MS-DOS mode.
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1. Insert this disk into your A: drive, and at the “A:\>” prompt in DOS type install e.

2. Follow the on-screen prompts and complete the installation. Follow these steps with all of the
provided install disks to ensure that all components are installed, and working in the DOS portion
of your operating system.

❐ Remember to always reboot after making any changes to your system.

PACKARD BELL SYSTEMS
It has been determined that the SOUND144, SOUND16A, and some other varieties of Packard
Bell-specific sound cards may not be entirely 100% Sound Blaster compatible. If you are receiving
poor quality or no sound when choosing Sound Blaster as your sound card during installation, you
need to change the mode that your card is set to run in to ensure consistent compatibility.

The sound systems mentioned above support Sound Blaster emulation by default, but can also be
configured to emulate the Microsoft Sound System. If you are receiving no sound when choosing
Sound Blaster during the installation or setup, follow the steps below to set up your card as a
Microsoft Sound System.

SOUND144 SOUND CARD OWNERS
You need to add the following line to the AUTOEXEC.BAT file on a boot disk or your C: drive.
(WARNING: We strongly recommend using a boot disk [see Creating a DOS Boot Disk on p.
13], as this will not make any permanent changes to your system’s configuration.) The correct
syntax of this line is as follows.

C:\SOUND144\UTILITY\SETMODE /MSS

SOUND16A SOUND CARD OWNERS
Add the following line to AUTOEXEC.BAT:

C:\SOUND16A\UTILITY\SETMODE /MSS

MMPRO16 SOUND CARD OWNERS
Add the following line to AUTOEXEC.BAT:

C:\MMPRO16\UTILITY\SETMODE /MSS
For owners of a variety of other Packard Bell sound cards the same method will apply, i.e.:

C:\<card name>\UTILITY\SETMODE /MSS
REMEMBER: Always reboot after making any changes to your system, and re-run the install pro-
gram for your game. Choose WINDOWS SOUND SYSTEM and then click TEST to test your
choice. If you still have sound problems, consult the reference material for other noted sugges-
tions.
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CREATING A DOS BOOT DISK
Starting your computer using a DOS boot disk allows you to free up more memory without alter-
ing the CONFIG.SYS and AUTOEXEC.BAT files on your hard drive. Booting your computer
with a DOS boot disk does not prevent you from accessing your hard drive, it merely provides a
different method for configuring your memory. After you create a DOS boot disk, you will copy
your CONFIG.SYS and AUTOEXEC.BAT files from your hard disk onto the boot disk and mod-
ify these copies. We recommend using this procedure to avoid altering the CONFIG.SYS and
AUTOEXEC.BAT files on your hard drive, which may affect your memory configuration for run-
ning other applications.

Below are instructions for creating a DOS boot disk. Please follow these steps exactly.

✔ NOTE: To create a DOS boot disk you must use a disk that will fit in your A: drive. Your
computer will not boot from the boot disk if it is inserted in the B: drive.

1. From the DOS prompt, type C: and press e.

2. Place the blank disk into drive A:.

3. Type FORMAT A:/S e. Be sure to include the spaces.

➮ You will be prompted to insert a blank disk into drive A:. Do so if you haven’t already,
and press e.

4. Once the disk is finished formatting, you will be asked to label (name) the disk. Type in a
name and press e or simply press e for no name.

5. A prompt appears asking whether you wish to format another disk. Type N and press e.

To configure your DOS boot disk to free up additional conventional memory and enable Extended
memory:

1. Back up your CONFIG.SYS and AUTOEXEC.BAT files before editing them so that you can
return to the originals if you have any problems:

• a. At the C:\ prompt, type COPY C:\CONFIG.SYS C:\CONFIG.BAK and press e.
• b. Type COPY C:\AUTOEXEC.BAT C:\AUTOEXEC.BAK e.

2. Copy the CONFIG.SYS and AUTOEXEC.BAT files from the root directory on your hard
drive (C:\) to the root directory on the boot disk that you have just created (A:\):

• a. At the C:\ prompt, type COPY C:\CONFIG.SYS A:\ e.
• b. Type COPY C:\AUTOEXEC.BAT A:\ e.

3. Open the boot disk copy of the AUTOEXEC.BAT file (on A:) using the EDIT program from
MS DOS 5.0 or greater:

• a. From the C: prompt, type CD \DOS e.
• b. Type EDIT A:\AUTOEXEC.BAT e.
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4. From the boot disk copy of the AUTOEXEC.BAT file, delete all lines except the following
(items enclosed in [brackets] indicate system-specific variables):

Line Notes
PATH=[Path] [Path] will vary by system
PROMPT $P$G
[Your sound card driver] Example:

SET SOUND = C:\SBPRO
SET BLASTER = A220 I7 D1 T4)

[Your CD-ROM driver] Example: C:\DOS\MSCDEX.EXE /S /D:SONY_000
C:\[directory]\MOUSE.COM (Or equivalent mouse driver)

✔ NOTE: If your mouse line looks different from the examples above, you may not be using the
MOUSE.COM mouse driver. Do not change this line if it looks different from the examples
above. Drivers with a .SYS extension will be loaded through the CONFIG.SYS file and
should be left in place when you are editing that file. If you have other questions about load-
ing your particular mouse driver, consult your mouse or DOS manuals.

5. Save the edited AUTOEXEC.BAT file and open the boot disk copy of the CONFIG.SYS file
from within EDIT.

❐ To save, press a-F to bring down the File menu, then type S.
➮ To open, press a-F, type O, then type a:\config.sys and press e.
6 . While still in EDIT, delete all lines from the boot disk copy of the CONFIG.SYS file

EXCEPT the following:
Line Notes
DEVICE=C:\DOS\HIMEM.SYS (Or C:\WINDOWS\HIMEM.SYS)
DOS=HIGH
BUFFERS=30
FILES=30
[Your CD-ROM device driver] Example: C:\DEV\SLCD.SYS /D:SONY_000 /B:340 /M:P
/V /C

Your CONFIG.SYS file should now look like the above example. If it does not, edit it now to
make it look similar to the text above.

7. Save the edited CONFIG.SYS file and exit the EDIT program.

❐ To save, press a-F, then type S.
➮ To exit the Edit program, press a-F, then type X.

You now have a boot disk which should free up enough conventional memory and set up enough
Extended memory to run the program. The boot disk bypasses the AUTOEXEC.BAT and CON-
FIG.SYS files on your hard drive and configures your memory based on the AUTOEXEC.BAT
and CONFIG.SYS files on your boot disk.
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TO START UP YOUR MACHINE USING THE DOS BOOT DISK:
1. Insert the DOS boot disk into drive A:, then restart your machine. Your computer will boot
up to the A:\ prompt.

2. Type C: and press e to return to your hard drive.

✔ NOTE: If you want to return your system to its normal memory configuration, simply
remove the DOS boot disk from the A: drive and restart your machine.

For more information on editing your CONFIG.SYS and AUTOEXEC.BAT files, or on changing
your startup configuration, consult your DOS manual.

WINDOWS® 95 USERS
Problem: I’m not sure if I can run KKND from Windows 95. I’m frightened.

Solution: Just stay calm. KKND runs fine from Windows 95-just refer to the Starting the
Game from Windows 95 section of this ref. card. What’s that? You’ve got an earlier Windows
version? Hmmm... you should really shut it down, re-start your computer with a DOS boot disk
(see Creating a DOS Boot Disk on p. 13), and run KKND from clean DOS. Don’t launch an
MS-DOS prompt and try running KKND from the command line, however. Just don’t.

SWITCHING TO MS-DOS MODE
If you have difficulty running this program from the Windows 95 operating system, we recom-
mend switching to MS-DOS mode. To configure your computer for MS-DOS mode:

1. Left-click on the ÿStart button on the Taskbar. The Start menu opens.

2. From the Start menu, click on Shut Down….

3. From the Shut Down Windows dialog box that appears, click on Restart the computer in
MS-DOS mode, then click Yes. The computer restarts in MS-DOS mode.

4. When you return to the Command Prompt, type cd\kknd e. (If you installed to a differ-
ent directory, substitute the appropriate directory.)

5. To start the game, type KKND e.

6. To return to Windows 95 after you exit from the game, type exit e at the DOS prompt.

CREATING AN MS-DOS MODE ICON
Although your CD-ROM drive, sound card, mouse, and other peripherals may work perfectly
with Windows 95, they may need to be configured manually to work in MS-DOS mode. If you
are having problems running this game from Windows 95 that the previous instructions didn’t
solve, we recommend that you create a new MS-DOS mode icon that can be used to create a
proper MS-DOS environment for this and other DOS programs. 

Before you start, you’ll need to gather a few details from your system. Please follow the instruc-
tions below according to your system. It’s important to note that the instructions should be used
in addition to your PC manufacturer’s supporting documentation.
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STEP 1: DETERMINING YOUR CD-ROM DEVICE DRIVER
If you purchased a PC with Windows 95 already installed:

Before you create an icon, you need to gather details of your DOS CD-ROM device driver and its
location (or path) on your hard drive. This depends on where your PC retailer or manufacturer has
placed them on your system. You may find the name of your CD-ROM device driver in your CD-
ROM documentation. Typically, this is 4-8 characters in length and ends in .SYS (e.g., SBCD.SYS,
SLCD.SYS, CDMKE.SYS, MTMCDAI.SYS, ATAPI_CD.SYS, etc.). You can also find this by
going into DOS and listing the contents of your CONFIG.SYS file. To do this, type type
config.sys e at the “C:\>” prompt. If it is in this file it looks something like this:

DEVICE=C:\[path]\[CD device driver].SYS /D:xxxxx.
This line varies according to your PC, but it will definitely start with DEVICE or DEVICEHIGH,
and should contain a “/D:xxxx” in the line–e.g., DEVICE=C:\SB16\DRV\SBCD.SYS
/D:MSCD000. If you have done the above and cannot locate the name of your CD driver, you
need to speak to your PC retailer/manufacturer. If you have found the line, copy it down exactly
appears onto a piece of paper. Proceed to Step 2.

If you installed Windows 95 onto a PC previously running another version of Windows and DOS:

Before you can create an icon, you need to have details of your DOS CD-ROM driver and its loca-
tion (or path) on your hard drive. Typically, the driver is 4-8 characters in length and ends in .SYS
(e.g., SBCD.SYS, SLCD.SYS, CDMKE.SYS, MTMCDAI.SYS, ATAPI_CD.SYS, etc.). You can
find this by going into DOS and listing the contents of your original CONFIG.SYS file. To do
this, type type config.dos e at the “C:\>” prompt. It looks something like this:

DEVICE=C:\[path]\[CD device driver].SYS /D:xxxxx.
This line varies according to your PC, but it will definitely start with DEVICE or DEVICEHIGH,
and should contain a “/D:” in the line–e.g., DEVICE=C:\SB16\DRV\SBCD.SYS /D:MSCD000.
When you find the line, copy it exactly as it appears onto a piece of paper. Proceed to Step 2.

STEP 2: CREATING THE ICON AND SPECIFYING CONFIG.SYS AND AUTOEXEC.BAT PARAMETERS
1. Start the Windows 95 operating system. (If you are in DOS, type exit e.)

2. Right-click anywhere on your desktop to bring up a small menu. Left-click on New, then left
click on Shortcut. The Create Shortcut menu appears.

3. In the Command line, type c:\windows\command.com, then click Next>, followed by Finish.
If Windows 95 is installed in a directory other than C:\WINDOWS, replace the text ‘c:\windows’
with the appropriate directory.

4. Right-click the new MS-DOS prompt icon and select Properties. Select the Program tab at
the top of the window and click Advanced… to view the Advanced Programs Settings menu.

5. Select the MS-DOS mode box, then click the Specify a new MS-DOS configuration option.
Two boxes appear below.
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6 . The first box is the CONFIG.SYS file that is used when Windows 95 restarts in DOS
mode. Leave the two lines that are already there and add the following lines:
files=30
buffers=30
device=c:\[CD-ROM directory]\[CD-ROM device driver] /d:mscd000

7. Add the CD-ROM device driver line just as you copied it down earlier, but leave out the
‘/d:xxxxx’ assignment, and use the one shown above instead (/d:mscd000).

8. In the AUTOEXEC.BAT for MS-DOS mode box, add this line:

C:\WINDOWS\COMMAND\MSCDEX.EXE /D:MSCD000
If Windows is installed in a directory other than C:\WINDOWS, substitute the appropriate path
for ‘c:\windows’.

9. Click on OK to close, then click on OK again to return to the desktop to use your new icon.

10. To use your new icon, double click on it. A box appears to advise you that you are entering
MS-DOS mode. Click Yes to confirm, and the computer restarts in MS-DOS mode. You can then
install and play the game according to the DOS instructions.

CORRECTING SOUND PROBLEMS
If you experience problems with your sound card you need to ensure that you have all correct
device drivers loaded in the CONFIG.SYS and AUTOEXEC.BAT files. Using the same procedure
as you did to locate your CD-ROM device driver, find the sections that refer to your sound card
and copy them down onto a piece of paper.

✔ TI P: Try looking for the following key words: BLASTER, SOUND, and SB. For example,
the required settings for a Sound Blaster AWE 32 might be:
SET BLASTER=A220 I5 D1 H5 P330 T6
SET SOUND=C:\SB16

There will be other drivers that pertain directly to your sound card that do not start with ‘SET’.
There should be at least one driver line in CONFIG.SYS that starts with ‘DEVICE’ or ‘DEVICE-
HIGH=’, and in many instances multiple lines in AUTOEXEC.BAT (e.g., C:\SB16\AWEUTIL,
C:\SB16\DIAGNOSE /S, C:\SB16\SB16SET). These lines and any corresponding driver lines should
be included. For more information, refer to your system documentation and/or manufacturer.

LOADING A MOUSE DRIVER
Since a mouse is required for the game, you also need a DOS device driver for your mouse.
Typically this driver will be called MOUSE.COM, and may be found in the C:\MOUSE directory.
If this is the case, add the following line to the AUTOEXEC.BAT file:

C:\MOUSE\MOUSE.COM
If you cannot locate your DOS mouse driver, please refer to your mouse documentation and/or
manufacturer for more information.
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TECHNICAL SUPPORT
If you have questions about the program, our Technical Support Department can help. Please be
sure to include the following information in your letter, fax, or e-mail message:

❐ Computer manufacturer
❐ Operating system (Windows 95, DOS 6.22, etc.)
❐ CPU type and speed in MHz
❐ Amount of RAM
❐ Sound card type and settings (address, IRQ, DMA)
❐ Video card, CD-ROM, Mouse driver and version
❐ Joystick and game card (if any)
❐ A copy of the CONFIG.SYS and AUTOEXEC.BAT files from your hard drive.
❐ A description of the problem you’re having.
If you need to talk to someone immediately, call us at (415) 572-2787 Monday through Friday
between 8:30 AM and 4:30 PM, Pacific Time. Please have the above information ready when you
call. This will help us answer your question in the shortest possible time.

Electronic Arts Technical Support Fax: (415) 286-5080.
P.O. Box 7578
San Mateo, CA 94403-7578

HOW TO REACH US ONLINE

COMPUSERVE Game Publishers A Forum
(GO GAMAPUB)
Or send e-mail to 76004,237

AMERICA ONLINE Send e-mail to ELECARTS

INTERNET E-MAIL support1@ea.com
Or send e-mail to elecarts@aol.com or 76004.237@compuserve.com

Warranty inquiries cswarranty@ea.com

WORLD WIDE WEB: Access our Web Site at http://www.ea.com

FTP Access our FTP Site at ftp.ea.com
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If you live outside of the United States, you can contact one of our other offices.

In Austral ia, contact: In the United Kingdom, contact:
Electroic Arts Pty. Ltd. Electronic Arts Ltd.
P.O. Box 432 P.O. Box 835
Southport Qld 4215, Australia Slough SL3 8XU, UK
Phone (753) 546465.

In Australia: For Technical Support and Game Hints and Tips, phone the EA HOTLINE: 1 902
261 600 (95 cents per min.) CTS 7 days a week 10 AM—8 PM.
If you are under 18 years of age parental consent required.

NOTICE
Electronic Arts reserves the right to make improvements in the product described in this manual at any
time and without notice. This manual and the software described in this manual are copyrighted. All
rights are reserved. No part of this manual or the described software may be copied, reproduced, trans-
lated, or reduced to any electronic medium or machine-readable form without the prior written consent
of Electronic Arts, P.O. Box 7578, San Mateo, California 94403-7578, Attn: Customer Support.

KKND is a trademark and Melbourne House is a registered trademark of Beam Software.

Software © 1997 Beam Software PTY LTD.

Documentation © 1997 Electronic Arts. All rights reserved.

Pentium is a trademark of Intel Corporation. Sound Blaster, Sound Blaster Pro, Sound Blaster 16, and
Sound Blaster AWE32 are trademarks of Creative Technology Ltd. Advanced Gravis, PC Gamepad,
Gravis, Ultrasound, and GrIP are trademarks of Advanced Gravis Computer Technology Ltd. Ensoniq
and Soundscape are trademarks of ENSONIQ Corp. Windows Sound System is a trademark and
Microsoft, MS-DOS, and Windows are registered trademarks of Microsoft Corporation.

Electronic Arts is a registered trademark of Electronic Arts.

IMGS  and the IMGS logo are trademarks of IMGS, Inc.
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USING THE ELECTRONIC DOCUMENTATION
The electronic documentation is viewable with an Adobe Acrobat reader version 2.1 or later. The
game CD includes installation software for the Acrobat 3.0 reader. The viwer will work in both
Windows 3.1 and Windows 95.

NOTE: To run the Adobe Acrobat reader simultaneously with the game software, you must have at
least 4 MB of RAM and 5 MB hard drive space free, in addition to the game’s listed requirements.

QUICK STEPS
Platform Installing/Viewing

Windows 95 Insert game CD. From the autorun menu, select REFERENCE, then
INSTALL ACROBAT.

Start Acrobat/view file (Insert game CD. Select  REFERENCE, then VIEW EDOCS.)

Windows 3.1 Run <CD drive>:/EDOCS/ar32e301.exe

Start Acrobat (From Program Manager, select File, then Run. Select the Acrobat
Reader 3.0 icon.)

WINDOWS 95
To install the Adobe Acrobat reader:

1. Insert the game CD-ROM into the CD drive.

Wait for the Autorun menu to appear. (If it doesn’t, select My Computer. Then, double-left-
click on the CD icon, and then on AUTORUN.EXE.)

2. Left-click on REFERENCE. (This runs AR32E301.EXE, located in the EDOCS directory on the CD.)

3. From the new screen that appears, left-click on INSTALL EDOCS .

4. Select one of the options that appears onscreen:

INSTALL ACROBAT Launches the Acrobat setup program.

Follow the onscreen prompts to install the viewer program files.

During the install process, you’ll be prompted to install Quick Time. You do not need this
program to view the documentation. To avoid Quick Time installation, click exit when
prompted to install it.

VIEW E-DOCS Opens the elecronic manual.

If you receive an error message, you may not yet have installed Adobe Acrobat, or you may
have installed it incorrectly. Try uninstalling then re-installing it.

CANCEL Closes the launcher screen and returns to Windows 95.
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WINDOWS 3.1
NOTE: You do not need to install Quick Time to use the documentation. You can quit Quick
Time installation by clicking EXIT when it tries to install the program.

To install the Adobe Acrobat reader:
1. In the Program Manager, select Run from the File menu.

2. Type the following line and then press e. Replace the bracketed information with the letter
of your CD-ROM drive:

<CD drive>:\ACROWIN\DISK1\SETUP.EXE

3. Follow the instructions that appear onscreen to install Acrobat.

To activate Acrobat/open the manual:
1. From the Program Manager, select the File menu, then Run.
2. Double-left click on the Acrobat Reader 2.1 icon. (If the icon is not visible, double-left click
on the Acrobat program group icon to open the Acrobat window.)

3. Select the File menu, then Open.
4. Select the CD drive and switch to the EDOCS folder.

5. Double-left click on MAIN.PDF.

UNINSTALLING/RE-INSTALLING

WINDOWS 95
If you ever want to remove the Adobe Acrobat viewer from your system in Windows 95, select
Start, then Settings/Control Panels. Then, select Add/Remove Programs. Finally, select
Acrobat Reader from the list of installed programs and left-click the ADD/REMOVE PROGRAM but-
ton. You can then reinstall as described on the previous page by using the Autorun menu.

WINDOWS 3.1
To remove the Adobe Acrobat viewer from your system in Windows 3., simply delete the Acrowin
directory from your hard drive. You can then reinstall as described on the previous page.

ACROBAT HELP
To activate help, select HELP from the Acrobat menu bar. Then, select Online Reader Guide.

The README.TXT file and Adobe Acrobat software license agreement are on the game disc under
the acrowin directory. These files contain additional information on this program.
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MANUAL ORDER FORM
To order the printed manual and full-color reference card, please send this form along with check
or money order for $5.00 (US$ must be drawn on a US or Canadian bank).

Electronic Arts

P.O. Box 7530

San Mateo, CA 94403

Attn: CD Classic Manuals

Name

Address

City State Zip

KKNDTM

If you need to contact us regarding the documentation, please call us at (415) 513-7555.
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1450 Fashion Island Blvd. San Mateo, CA 94404

part #?
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